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1. Purpose 
 

The purpose of this document is to guide the system’s installer with the steps 

necessary to install and configure the Universal Devices’ ISY system and operate 

the GUI. 

 

ISY comes configured for communications with the device(s) of your choice. The 

package contains: 

i. Power supply 

ii. Ethernet cable (Blue Cable) 

iii. A Serial/RS232 cable – for advanced administrative tasks. If you 

would like to view system status using Windows Hyper-terminal or 

any other terminal emulation software 

iv. Documentation and Utilities disk  

v. Quick setup guide 

 

 

 

2. Theory of Operation 
All ISY systems are empowered with UPnP (Universal Plug & Play) stack 

through utilization of which all the devices on the network can seamlessly 

communicate with each other and other computers on the network. ISY systems 

come embedded with their own browser based GUI and, as such, there is no need 

for any software installation besides the normal Java runtime and, optionally, 

Excel for trending and reporting. 

 

UPnP enables the devices on the network to automatically show up as resources 

on the “Network Neighborhood” or “My Network Places” on host computers just 

like a shared printer. For UPnP to work, the devices (and specifically ISY 

systems) need to be able to advertise their presence on the network and, 

furthermore, be able to communicate their state changes to the network. In this 

respect, then, the main prerequisites for successful operations are 

i. Network enabled environment 

ii. Configuration of firewall programs (besides Windows Firewall) to allow 

for the devices to communicate with the host system beyond the local 

network 
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3. Installation and Configuration 
Configuration is required only if ISY does not show up automatically. 

3.1 Installation 

Please perform the following steps before plugging the ISY into power: 

i. Connect the Ethernet cable to ISY and to your network hub. Note: the 

network must be DHCP enabled. If your DHCP is not enabled, please 

consult ISY Installation and Configuration Guide on the accompanying 

CD 

ii. Connect the Serial communications cable, provided with your Insteon 

PLM (sold separately), to the connector marked Port A on the ISY and to 

your computer. 

Plug in the power supply into ISY and then into a power outlet. 

 

3.2 Prerequisites 

3.2.1 Host Computer Software 

i. Windows XP (for other versions of Windows, a separate guide is 

provided) 

ii. Internet Explorer 6 and above 

iii. Java 1.5 (JRE 1.5) – included in the setup disk 

iv. Microsoft Excel, for trending and charts 

 

3.2.2 Network 

ii. DHCP enabled network 

iii. Ethernet topology 

 

3.3 Host Computer Configuration 

Configuration is comprised of three very easy steps: 

i. UPnP Configuration 

ii. Java Installation 
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3.3.1 UPnP Configuration 

UPnP is normally disabled on all computers by default. In order to make sure 

and/or to configure UPnP, please follow the following steps (refer to Figure 1): 

i. Click on My Network Places (either on the Start Menu or Desktop) 

ii. On the left Navigation Pane 

a. If you see “Hide icons for networked UPnP devices”, you are done. 

No further action is necessary 

b. If you see “Show icons for networked UPnP devices”, click on it 

and let the system get configured. You are done. 

 

 

Figure 1– UPnP Configuration 

 

3.3.2 Java Installation 

If you already have JRE 1.5v.6 installed, then no further action is necessary. 

Otherwise, click on the jre/jdk-1_5_0_11-windows-i586-p.exe on the installation 

CD to install JRE. 

 

4. Additional Hardware Required 
Please purchase and plug in the SmartHome PLM Version 4.6 in port A of the ISY. 
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5. Starting the GUI on a Host Computer 
If you already have Java installed and UPnP enabled, all you have to do is to click on the 

icon My Lighting (refer to Figure 1) appearing in the My Network Places (refer to 

Figure 2) either on the Start Menu or Desktop.   

 

If the “My Lighting” icon did not show up on your My Network Places you will need to 

follow the configuration steps below. 

Configuration is comprised of three very easy steps: 

iii. UPnP Configuration 

iv. Java Installation 

v. If you have any other network firewall software, please contact us to walk you 

through the configuration. 

 

Figure 2– Network neighborhood/My Network Places 

 

In your Network Neighborhood/My Network Places double click on the My 

Lighting icon, see Figure 1 – UPnP Configuration.  

 

Once you double clicked the My Lighting icon in your Network neighborhood a 

browser window will appear, See Figure 3 – Initial Browser.  
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Figure 3 – Initial Browser 

 

Please do not close this browser window. You can minimize it but you can not 

close it at any time while the GUI is running or the application will terminate. 

Following the above browser that opened the ISY GUI will appear and you will 

be presented with a user-id/password dialog box, See Figure 4. Please enter 

admin for both the user-id as well as the password. 

 

Figure 4– ID & Password 
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6. Main GUI Components 
The ISY GUI is very intuitive and is essentially comprised of four complementary panes 

(refer to Figure 5) 

i.   Top Pane  

ii.  Navigation Pane or Tree View  

iii  View Pane  

iv.  Bottom Pane 

 

Figure 5– Main GUI Components 

6.1 Top Pane 

The Top Pane is located in the top section of the GUI and it always contains the menus, 

the tool bar, the date, location and sunrise and sunset times of that specific location. This 

section always remains the same no matter which action you are performing. 

6.2 Navigation Pane or Tree View 

The Navigation Pane, also known as the Tree View, is located on the left section of the 

GUI. The Navigation Pane is a tree view at the top most of which is the whole Network.  

 

The Navigation Pane may expand, grow, and shrink based upon the number devices have 

been linked to the controller as well as user actions. There are only five distinct types of 

nodes that you may find on the tree view (refer to left pane in Figure 5): 
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At the top of the tree view you have: Configuration, Schedules and Trigger. The bottom 

section of the tree view offers a configurable view of all the devices you can control.   

Clicking on the icons on the tree view brings up the associated view in the view pane. 

Right clicking on the icons on the tree view brings up a menu of actions appropriate only 

for that node on the tree. 

 

6.3 View Pane 

The View Pane is located in the main and right sections of the GUI. The view pane 

provides a tabulation of all the pertinent and important information for all the devices you 

can control in one place. It is specifically designed to give you an immediate access to 

most needed information during setup while providing simple navigation features enable 

the user to jump to a device (such as light) to perform necessary actions. 

 

The view is displayed when any of the following nodes are selected: 

i. Root Node – in this view, all the devices in the network are captured regardless of 

their physical attachment to any ISY. 

ii. Physical Device (ISY) Node – in this view, only those devices that are attached 

to the selected ISY are presented. 

iii. Group Node – in this view, only those devices that are attached to the selected 

group are presented. 

 

The View Pane provides a very useful and intuitive navigation (refer to Figure 5) 

mechanism: when a specific row in the table is clicked: 

i. The respective device  is selected in the Tree View 

ii. The view is changed to show the details related to that device and the user can 

immediately change the settings for that device. 

6.4 Bottom Pane 

The Bottom Pane is located at the bottom section of the GUI. Depending on the option 

selected on the Tree View it will contain the actions you can perform. If you selected a 

device in the View Pane or the Tree View; the Bottom Pane will show the actions you 

can perform to the device and the groups this device belongs to. 
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7. Top Pane - Menu 
 

This section details the functionalities and the operations of each menu option listed in 

the Top Pane. 

7.1 File Menu 

Please see Figure 6 for all File Menu options. 

 

Figure 6– File Menu 

7.1.1 Logon 

The Logon option will be enabled if you are not connected to the ISY. The system will 

prompt you that you have lost the connection and you must login. Once you select this 

option you will be required to enter your user name and password. 

7.1.2 Set Userid/Password 

Once this menu option is selected the user can change the user name or password or both. 

The new user name or password, or both should be typed in the appropriate line. Please 

make sure you remember the new user name or password as the old default account of 

user name and password admin will no longer work in future logins.  

Note: Lost passwords are not retrievable. The only way of getting back to the system is 

by performing a factory reset which would erase all the settings.  

 

7.1.3 Backup Configurations 

Once this menu option is selected the user will select or type the location and file name 

which will save the current configuration. All the controllers’ configurations will be 

saved to this file. 

 



 

 - 13 -  

7.1.4 Restore Configuration 

Once this menu option is selected the user has the ability to select the file to which he 

previously saved or backed up all the configurations of the controller. 

 

7.1.5 Disable Internet Access [ISY] 

The controller default setting is to have internet access enabled. If you would like to 

disable internet access to the controller select this option. It is reversible and you will be 

presented with the Enable Internet Access menu option. 

7.1.6 Exit 

Once this menu option is selected this application will end and the browser window will 

close. 

7.2 Link Management Menu 

Please see Figure 7 for all Link Management menu options. 

 

Figure 7– Link Management Menu 

7.2.1 Start Linking 

For all devices, with the exception of ControLinc, when new devices need to be added to 

the ISY you must select this option and then click the linking button on the new device 

(light, switch etc.)  for as many devices as you desire.  This performs the same action as 

the Start Linking button on the tool bar. The Start Linking button will change and will 

show an X sign. The new device/s should automatically show up on the ISY application. 

This may take a few seconds. Please click the Cancel button on the Linking Dialog after 

all your new devices have been linked to the controller and show up on the GUI. You can 

then rename each device and change its various attributes. Please follow each device as to 

the location of its linking button. The device should blink indicating it is in linking mode. 

Please make sure you first select the Start Linking option from the ISY GUI and then 

click the linking button on the device itself. Other wise the device will not be linked to 

the controller. 

 

For ControlLinc, click on the Link a ControLinc menu option and follow instructions on 

the screen. 

7.2.2 New Scene 

Once you click this option you will be presented with a window requesting a name for the 

new Scene. Enter the name you prefer (the name can be changed at a later time.) The new 
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scene will be added to the tree view on the left pane. You can click and drag any one of 

the devices already linked to the system into this scene. If you click and dragged correctly 

you will see a plus sign next to the device you are dragging. It may take a few seconds to 

copy the device and all it’s attributes to the new scene. You must wait until the hour glass 

and/or progress bar disappears before performing additional actions. Copying the device 

to the new scene will not delete it from the master list of devices or from the scene/s they 

already belong to.  

7.3 Tools Menu 

Please note that the Tools Menu will not appear immediately as the other menus, it will 

take a few seconds before it appears. This is due to the amount of time it takes to 

download the chart and floor-plan applications from ISY. See Figure 8 for all Tools 

Menu options. 

 

Figure 8– Tools Menu  

7.3.1 Trend(Chart) 

Once you select this option you must wait a few seconds. You will be presented with 

another window which offers multiple trending and charting options for each device, for 

a group of devices or for all the devices you are controlling. 

 

7.3.1.1 Trend - Categories Menu 

 Statues – This option will display 

 On Level  

Ramp Rate 

 

7.3.1.2 Trend - By Group Menu 

This menu will display each device and each group available in the controller. Once a 

device or a group is selected you can choose one of the three options under the Categories 

Menu and the chart displayed will be specific to the device or group you selected. You 

can go back to the Categories Menu and choose each available option for the device or 

group selected in the Group Menu and the chart displayed will contain only the 

information specific to that device or group of devices. 

 

7.3.1.3 Trend - Log Menu 

Once you select this option a Windows Excel window will open. You will be requested to 

allow macros to run. You must select OK for the macro to run and to have access to the 

log file. The log file contains the date the data was captured and the statues, on level and 

ramp rate for each device and group of devices. If you the log file is empty you probably 

don’t have macros enabled. You must enable macros in Windows Excel. To enable 
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macros you must click on the Tools menu, then select Macros, then select Security. 

Security should be set to either Medium or Low. 

7.3.2 Log(Excel) 

This option is the same as the Trend – Log menu option. 

7.3.3 Reset History 

This menu option allows you to reset the information captured in the log file. The 

information already captured will be deleted and the log will restart from this point of 

time. Once you select this option you will be presented with a confirm request. You may 

select OK to proceed and delete the current file or Cancel to exit and the current log will 

not be deleted. 

7.3.4 Floor Plan 

This menu option provides a graphical representation of the location of each device. It 

allows you to create locations (rooms) and place devices in their physical location. This 

will help if at a later time you would like to know where the specific device you are 

controlling is located. 

Once you select this option you will be presented with a new window. It will have a Key 

icon at the top. By selecting the key you will be presented with the option of creating a 

new location. You may name it any name which helps correlate this graphical 

representation to the physical location. You can click and drag a group of devices First 

Floor to the Floor plan. The system will create a new room in the floor plan which will 

contain all the devices that are part of the First Floor group. You can then click and drag 

each device to its physical location within that room. For example: Hall 1 can be dragged 

to the top left of the room because that’s its physical location. 

7.4 Help Menu 

See Figure 9 for all Help Menu options. 

 

 

Figure 9– Help Menu 

7.4.1 About 

The About menu option will provide the current IP, port and ISY version number that the 

control system is using. It will also provide the status of the internet access, whether it is 

enabled or disabled. Internet access can be changed on the File menu. 
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7.4.2 User Guide 

The User Guide menu option will open the user guide for the ISY using Adobe Acrobat 

reader. 

7.4.3 Manually Upgrade ISY 

This option will provide access to a browser which allows you to select the new ISY file 

and by selecting it you will begin to upgrade the software on the controller. An alternate 

and a preferred method to upgrading you controller is… 
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8 Top Pane – Tool Bar 
 

 

This section details the functionalities and the operations of each Tool Bar icon available 

in the Top Pane. 

8.1 Expand All 

The Expand All is the first button on the tool bar. Its symbol is a plus sign. Please refer to 

Figure X10. Once you click on this button all the groups on the Tree View will expand 

and all the devices within them will be listed. 

 

 

Figure 10– Expand All  

8.2 Collapse All 

The Collapse All is the second button on the tool bar. Its symbol is a minus sign. Please 

refer to Figure 11. Once you click on this button all the devices in each of the groups on 

the Tree View will collapse and minimize and you will only see the group names. 

 

 

Figure 11– Collapse All 

8.3  Sort 

The Sort button is the third button on the tool bar, see Figure 12. Pressing it will 

alphabetically sort all the groups and devices listed in the Tree View. 

 

Figure 12- Sort  

8.4 New Scene 

The New Scene is the fourth button on the tool bar, see Figure 13. It performs the same 

action as the New Scene option under the Link Management menu. Once you click this 

option you will be presented with a window requesting a name for the new Scene. Enter 

the name you prefer (the name can be changed at a later time.) The new Scene will be 

added to the tree view on the left pane. You can click and drag any one of the devices 

already linked to the system into this Scene. If you click and dragged correctly you will 

see a plus sign next to the device you are dragging. It may take a few seconds to copy the 

device and all it’s attributes to the new Scene. You must wait until the hour glass and/or 

progress bar disappears before performing additional actions. Copying the device to the 
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new scene will not delete it from the master list of devices or from the scene/s they 

already belong to.  

 

 

Figure 13– New Scene 

 

8.5 Start Linking 

For all devices, with the exception of ControLinc, when new devices need to be added to 

the ISY you must select this option and then click the linking button on the new device 

(light, switch etc.)  for as many devices as you desire.  This performs the same action as 

the Start Linking button on the tool bar. The Start Linking button will change and will 

show an X sign. The new device/s should automatically show up on the ISY application. 

This may take a few seconds. Please click the Cancel button on the Linking Dialog after 

all your new devices have been linked to the controller and show up on the GUI. You can 

then rename each device and change its various attributes. Please follow each device as to 

the location of its linking button. The device should blink indicating it is in linking mode. 

Please make sure you first select the Start Linking option from the ISY GUI and then 

click the linking button on the device itself. Other wise the device will not be linked to 

the controller. 

 

For ControlLinc, click on the Link a ControLinc menu option and follow instructions on 

the screen. 

 

 

Figure 14– Start Linking 

 

 

Figure 15– Stop Linking 

8.6 Floor Plan 

The Floor Plan is the sixth button on the tool bar, see Figure 16. It performs the same 

action as the Floor Plan option under the Tools menu. This button provides a graphical 

representation of the location of each device. It allows you to create locations (rooms) 

and place devices in their physical location. This will help if at a later time you would 

like to know where the specific device you are controlling is located. 

Once you select this option you will be presented with a new window. It will have a Key 

icon at the top. By selecting the key you will be presented with the option of creating a 

new location. You may name it any name which helps correlate this graphical 

representation to the physical location. You can click and drag a group of devices, such 
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as First Floor, to the Floor plan. The system will create a new room in the floor plan 

which will contain all the devices that are part of the First Floor group. You can then 

click and drag each device to its physical location within that room. For example: Hall 1 

can be dragged to the top left of the room because that is its physical location. 

 

 

Figure 16– Floor Plan 

8.7 Trend (Chart) 

The Trend (Chart) button is the seventh on the tool bar, see Figure 17. It performs the 

same action as the Trend (Chart) option under the Tools menu. Please see detailed 

description under the Trend (Chart) Menu option description. 

 

Figure 17– Trend (Chart) 

9. Left Pane – Configuration  
The Configuration icon is the top most icon in the Left Pane which, at least initially, is 

labeled Network.  The Configuration View allows the users to manage global setting 

such as date/time and notification settings. This view is divided into two sections (refer to 

Figure 18) 

i. Date/Time configuration which is on the top 

ii. Notifications configuration which is on the center 

 

Figure 18– Configuration View 
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9.1 Location Configuration 

To set or change the location of the ISY you must click on the Change Location button. 

For relatively accurate Sunrise/Sunset calculations, please select the closest city in which 

the ISY will be physically located. In Figure X the location is Los Angeles, CA. If the 

city you are located in does not appear on the list please select the closest city with the 

same time zone. 

9.2 Date and Time Configuration 

You can set or change the time and date in your ISY in two ways.  

• The first is by pressing the Synchronize Clock with Computer’s Time button. 

Once you selected this option the ISY will be automatically updated with the 

computers time. 

• The second is by pressing the Manually Adjust the Clock button. You can adjust 

the date and time by following these steps  

o Click on the Adjust Date/Time button; you will be presented with the 

Adjust Date/Time dialog 

o Choose the Daylight Saving Mode (top) 

o Enter the time 

o Choose the time zone 

o Choose the month 

o Choose the day (you can click on the day buttons) 

o Choose the year 

o Click Ok 

The ISY date and time will be updated immediately to reflect the new date and time. 

9.3 Messaging Configuration 

9.3.1 Messaging Providers 

The list on the left provides the method (email or text message) and a list of companies 

which provide messaging services. 

  

9.3.1.1 Email Message 

To receive notifications via Email from the ISY please select the Regular Email entry, it 

is the first entry on the Messaging Providers. Once Regular Email is selected you will be 

requested to enter the full email of the recipient at the bottom of the list. Enter the 

recipient’s email address and press the Add button. The recipient will be added to the 

recipients list which is located on the right bottom of the Messaging Configuration 

screen. You may add several recipients but you must add them one at a time. 

 

9.3.1.2 Text Message 

To receive a page or a text message from the ISY you must select your pager, cell phone 

or blackberry service provider from the list by clicking on their company name. Once you 

clicked the provider’s name you will be requested to enter the 10 digit pager or phone 

number of the recipient. Enter the recipient’s number and press the Add button. Please 

enter the digits only without any symbols. 
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Correct number entry: 18186310333 

Incorrect number entry: 1-818-631-0333 

The recipient will be added to the recipients list on the right. You may add several 

recipients who may have different messaging service providers. Please add the recipients 

one at a time. 

 

9.3.1.3 Recipients 
Recipients listed on the recipient list can be removed either one at a time or you can 

delete the complete list by using the Remove or Remove All button at the bottom of the 

Recipients list. You may also Edit each recipient by selecting their entry from the 

Recipients list and pressing the Edit button. 

 

Note: the Max # of Resend should be set to a minimum of 1 in order to get at least one 

notification. 

9.4 Notifications Settings 

The Notifications Settings on the top right of the Configuration screen allows you to enter 

the interval and the maximum number of notifications the ISY will send to each recipient. 

In Figure 19 the Interval is set to 1 hour and 2 minutes and the Max # of Resend is set to 

3. In this example a notification (email, page, and text message) will be sent to each 

recipient on the recipient’s list every one hour and two minutes. This notification will be 

sent three times. Once another different notification is processed by the system it will 

follow the same settings. It will also be sent every hour and two minute and no more than 

three times. 

 

Figure 19– Notifications Settings 
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10. Left Pane – Schedules 
 

ISY provides one of the most complete scheduling capabilities in the automation market 

while keeping scheduling related administrative functions to the minimum. The rich user 

interface enables the user to create complex schedules in a matter of seconds. As 

described before, Schedules View (refer to Figure 20) is activated either globally (to all 

devices) or per device. You may have up to 64 schedules. 

 

Schedules are presented in a familiar and easy to read tabular format the first column of 

which is always the English description of the schedule and following five columns of 

which are always: 

i. Location – The name of the device or group of devices/scene that the schedule 

applies to.  

ii. Action – The action the schedule will perform, such as device On or Off. 

iii. Active – If this schedule is active or inactive in which case it can be removed 

iv. On Hold – If this schedule has been put on hold and currently is not applicable 

(for example if you are on a vacation and the normal schedule is not necessary.) 

v. Last Run – shows the date and time when this schedule was last run 

 

 

Figure 20– Schedules View  

 

10.1 New Schedule 

To create a new schedule, simply click on the New Schedule button at the bottom of the 

Schedules View. This action will bring up the Schedule Configuration Utility (Refer to 

Figure 21) through the usage of which you can add different types of schedules as outline 
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in the following subsections. After you selected the location and time in the Schedule 

Configurator, click OK. You will be back in the Schedule View. Please select your 

schedule and click on the Action column, you will be presented with a drop down menu 

from which you should select the desired action.  

Please press the Save button at the bottom center of the schedules view. 

 

 

Figure 21- Schedule Configurator 

 

Note: You can add all the desired schedules before saving them to the ISY for execution. 

When you are done with creating all the desired schedules, click on the Save button at the 

bottom of the Schedules View. 

10.2 Adding a Schedule for a Specific Time 

This type of schedule is run only Once at a specific date and time. In order to create this 

type of schedule, on the Scheduler Configuration Utility: 

 

i. Click on the Once (at the left top) 

ii. Choose the desired time 

a. Either enter the time manually 

b. Select Sunset or Sunrise and the correlating time, based on your location, 

will be entered for you by the ISY 

iii. Choose the desired date 

a. Select the month by using the arrows at the bottom left and bottom right 

b. Select the day by clicking on the correlating number button, the selected 

day will appear in red text 

iv. Choose the location from the drop down menu at the top 

v. Click on Ok 
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vi. From the Schedule View select the appropriate Action by clicking on your 

schedule’ action column 

vii. Click on Save 

 

10.3 Adding a Schedule for Everyday at a Given Time 

This type of schedule is run Everyday at a specific time. In order to create this type of 

schedule, on the Scheduler Configuration Utility: 

i. Click on the Everyday (at the top left) 

ii. Choose the desired time 

iii. Click on Ok 

10.4 Adding a Repeated Schedule for Everyday  

This type of schedule is run Everyday at a specific time and is repeated at the desired 

interval within the desired duration (less than 24 hours). The desired duration should be 

entered at the Repeat Every entry location of the Schedule Configurator. For example the 

schedule can run every 15 minutes.  In order to create this type of schedule, on the 

Scheduler Configuration Utility: 

 

i. Click on the Everyday (at the top left) 

ii. Click on the Repeats (at the top left) 

iii. Choose the From time 

iv. Choose the To Time 

v. Choose the desired Repeat every interval (at the bottom center) 

vi. Click on Ok 

10.5 Adding a Schedule for Certain Days of the Week 

This type of schedule is run on Certain Days of the Week at a specific time. In order to 

create this type of schedule, on the Scheduler Configuration Utility: 

 

i. Click on the Every (at the top left) 

ii. Click on the desired  Days (on the left) 

iii. Choose the desired time or click on Repeats and choose the desired repeat times 

iv. Click on Ok 

10.6 Holding Schedules on a Certain Date 

Holding schedules is a powerful mechanism through which the schedules can be put on 

hold without the need for removing and adding schedules.  

In order to Hold Schedules on a Certain Date on the Scheduler Configuration Utility: 

 

i. Open the schedule by double clicking it or selecting it from the Schedule View 

and clicking Edit 

ii. Click on the Hold (on the lower left) 

iii. Choose the month, day, and year this hold should be applied 

iv. Click on Ok 
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Note: A Hold schedule at the highest level for location (ISY) will put all the schedules 

for all the devices in all the ISY in the network on hold.  

 

10.7 Holding Schedules for a Duration 

 

Holding schedules is a powerful mechanism through which the schedules can be put on 

hold without the need for removing and adding schedules. Not only you can Hold 

schedules for a Certain Date, you can also Hold schedules for a Duration of time. 

 

In order to Hold Schedules for a Duration of time, on the Scheduler Configuration 

Utility: 

i. Click on the Hold (at the bottom left) 

ii. Click on the Repeats (at the upper left) 

iii. Choose From and enter the desired date and time for the start of the hold 

iv. Choose To and enter the desired date and time for the end of the hold 

v. Click on Ok 

10.8 Editing an Existing Schedule 

To select an existing schedule simply click on it. The schedule’s row will turn pink and 

you can make changes to the actions by clicking on the Action’s entry for the selected 

schedule. You will be presented with a drop down menu from which you can select the 

desired action. To edit additional features of this schedule you can click on it once and 

select the Edit button or double click on the schedule. Please make sure you click the 

Save button in the Schedules view after you completed your changes otherwise your 

changes will not be saved on the ISY and will not take effect. 

10.9 Removing a Schedule 

Some schedules – such as those created for a Specific Time – become inactive once 

executed. Or, there might be the necessity for removing a schedule that is no longer 

required. In these cases, all one has to do is to click on the row containing the schedule 

and then clicking on the Remove button on the Schedules View. 

 

To remove all schedules simply click on the Remove All button on the Schedules View. 
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11. Left Pane – Triggers 
 

Triggers View, See Figure 22, allows for the configuration of actions and notifications 

based on certain events within the controller devices. Just like the Schedules, Triggers 

may be applied either globally (on all the devices on all the ISY) or locally on a specific 

device. 

 

Figure 22– Triggers  

11.1 Setting a Trigger 

To set a trigger: 

i. Click the New Trigger button (on the upper left) 

ii. Click the New Condition button – this will cause a new view to open up and allow 

you to select the new condition. For example: When Hall 1 is on 

iii. Click the New Response button – this will cause a new view to open up and allow 

you to select the reaction to the condition you just selected. For example: Set Hall 

3 to On. 

iv. Click the Apply Trigger button (on the upper left) 

v. You can now either follow the same process to enter another trigger or click the 

Save button 

 

You can select multiple condition and multiple responses as part of the same trigger. For 

example: 

Conditions  If Hall 1  

and Hall 2 are On 

Responses  Turn Hall 3 On 

Notify - This will notify all the contacts listed in the configurations view 

and will follow the rules for the notifications (such as max three 

notifications.) 
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Please make sure you click the Apply Trigger or Save each trigger otherwise your 

trigger entry will not be saved to the ISY and as such will be lost. 

 

Note: 

The maximum number of Trigger allowed is: 20.  

The maximum number of Conditions per Trigger allowed is: 6.  

The maximum number of Responses per Trigger allowed is: 6. 

 

11.2 Removing a Trigger 

To remove a Trigger please select is by clicking on it once and click the Remove button. 

Please press the Save button to update the ISY. 

11.3 Pending Notifications 

This will provide a status of the notifications which are still pending for the triggers. For 

example if the total notifications based on the trigger and the notification setup is three 

notifications and only one was already sent, the Pending Notifications will show two 

pending notifications. If you click on the Pending Notifications button all pending 

notifications will be deleted and no additional notifications will be sent for this trigger. 

11.4 Refresh 

If a Trigger does not show up please click the Refresh button. It should refresh the list 

based on the Triggers already saved on the ISY. 

 

 

 



 

 - 28 -  

 

12.   Left Pane – ISY 

12.2 Controller Icon 

The fourth icon on the left pane is the main group of all the devices on your ISY. In this 

implementation, as shown in Figure 23, it is called My Lighting. It may be called ISY 

depending on the software version you have. You may change this name. Its symbol is a 

computer to the left of the name (My Lighting or ISY.) 

 

 

Figure 23– Controller Icon 

This group will always contain all the devices that are linked to the controller. You can 

not delete this group. By selecting the controller and doing a right click you will be 

presented with a menu with three options: Query, Rename and Start Linking. 

12.2 Query 

When you select the Query option on the menu associated with the Controller’s group the 

ISY will start querying the network and searching the status of each device which is 

linked to the controller. It will update their status and the updated information will be 

presented in the table in the view pane. 

12.3 Rename 

The Rename menu option allows you to rename the ISY’s controller name. 

12.4 Start Linking 

For all devices, with the exception of ControLinc, when new devices need to be added to 

the ISY you must select this option and then click the linking button on the new device 

(light, switch etc.)  for as many devices as you desire.  This performs the same action as 

the Start Linking button on the tool bar. The Start Linking button will change and will 

show an X sign. The new device/s should automatically show up on the ISY application. 

This may take a few seconds. Please click the Cancel button on the Linking Dialog after 

all your new devices have been linked to the controller and show up on the GUI. You can 

then rename each device and change its various attributes. Please follow each device as to 

the location of its linking button. The device should blink indicating it is in linking mode. 

Please make sure you first select the Start Linking option from the ISY GUI and then 

click the linking button on the device itself. Other wise the device will not be linked to 

the controller. 

 

For ControlLinc, click on the Link a ControLinc menu option and follow instructions on 

the screen. 
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13. Scenes 

13.1 Left Pane - Scene Menu 

By selecting any of the scenes you created and clicking on the right mouse button you 

will be presented with the Group Menu. It contains three options: Query, Rename and 

Remove Scene.  

13.1.1 Query  

When you select the Query option on the menu associated with each group the ISY will 

start querying the network and searching the status of each device which is part of the 

selected scene. It will update their status and the updated information will be presented in 

the table in the view pane. 

13.1.2 Rename 

The Rename menu option allows you to rename the selected scene. 

13.1.3 Remove Scene 

The Remove Scene menu option will delete the selected scene or group and the rules 

associated with it. 

13.2 Scenes 

Scenes are a set of rules which you apply to a group. The rules are based on the actions 

your devices can perform and we can automate in the system. A scene can help create the 

right ambiance for a certain event by a simple click. For example in Figure 24 we have 

created a movie scene. The lights in the Family Room were set to be turned on at the 

desired light intensity while viewing a movie. 
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Figure 24– Family Room-Movie Scene 
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14. Device Properties 
When you click on a device its properties will show up in the view pane and the scenes 

which it belongs to will show up in the bottom pane. The bottom pane will also have the 

actions which can be performed on this device. Currently the  ISY support all 

SmartHome lights, switches and dimmers. Depending on the device which is linked to 

the system you will be presented with the actions the system can help you perform and 

automate. 

 

For example in Figure 25 the “Family Room1” light was selected and its properties are 

shown in the main pane.  

 

Figure 25– Scene Properties 

 

The properties shown are: 

• Off – Family Room 1 light is currently turned off 

• On Level is 100% - the intensity of the light when it’s turned on will be 100% of 

the light brightness 
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• Ramp Rate is 100% - the speed which the system will follow to turn on the light 

is full speed or 100%  

 

The bottom pane shows the actions you can perform on this light. The actions are: 

• On – The light will be turned on following the ramp rate settings 

• Fast On – The light will be turned on immediately regardless of the ramp rate 

settings 

• Off – The light will be turned of following the ramp rate settings 

• Fast Off – The light will be turned off immediately regardless of the ramp rate 

settings 

• Brighten – The light’s intensity will be increased 

• Dim – The light’s intensity will be lowered 

 

The tree at the right pane shows the scenes a device belongs or, in case of a 

switch/controller, devices (switches) that it controls. In the example shown in Figure 24, 

Main Master (KeypadLinc Button 1) controls all the lights as well as being controlled by 

a ControLinc (Button1) 
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15.   Errors and Error Messages 

15.1 Possible Errors 

15.1.1 Red Exclamation Mark  

• If you see a red exclamation mark next to a device then you have lost connectivity 

to that device. Wait a few second and see if the device comes back on its own. If 

it does not then the device might be faulty or something was changed in the 

environment which affects the connectivity between the device and the ISY. 

• If you see a red exclamation mark next to the Configuration option and all the 

devices listed in the Tree View, see Figure 26, you have probably lost 

connectivity to the ISY. You must re-login, select the Login option under the File 

Menu. If you are unable to re-login please reboot the ISY. 

 

Figure 26– Connectivity Lost 

 

15.1.2 A Sand Clock That Will Not Disappear 

Close the browser to end the GUI and double click on the ISY icon to re-enter the GUI by 

double clicking the ISY in your Network Neighborhood. 

15.1.3 Subscription ID Not Found 

You have lost your session. Click on File->Login to re-login to the system. 
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15.1.4 Socket open failed java.io.IOException: An existing 
connection was forcibly closed by the remote host 

There was a network outage. Please restart your browser. 

 

15.2 To Report a New Error 

To report a new error please send an email with the error description to: tech@universal-

devieces.com  

  

Please provide the error and the situation in which the error presents itself. If possible 

please include a screen shot. 
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16. Supported Devices 
16.1 Insteon enabled devices: 
Currently Available 

• Wireless lights  by SmartHome 

• Wireless switches by SmartHome 

 

Available by March 2007 

• Irrigation/Sprinkler system, EZRain, by Simple home net/Compacta 

International 

 

Available by May 2007 

• Gates, Garage Doors and Windows by Somfy 

• Doors by Weiland 

• Smoke Detectors by First Alert 

 

16.2 Non Insteon enabled devices: 

• Aprilaire Thermostats 

• XCI Thermostat 

• Jackson Systems  

o Zone Control Thermostats 

o Regular Thermostats 

o A/C Valves 

 

Please note in this version Insteon enabled devices and non Insteon enabled devices will 

show up in the same ISY GUI but can not be part of the same group. This feature will be 

available in future versions. 
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17. Registration 
Please register with Universal Devices to receive notifications and upgrade notices. 

Please register your unit at http://www.universal-devices.com/register . 
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